
Picasso Academy (BOT Demo)

Board Meeting

Date and Time
Sunday April 2, 2017 at 5:00 PM

Location
At the school

All Picasso Academy Board meetings are open to the public and will start promptly at
the scheduled time. Anyone who wished to speak during the public comment section of
the meeting must submit their request at least 48 hours in advance of the board
meeting in writing to the board secretary, Maria Monet, c/o Picasso Academy Main
Office.

Agenda
Purpose Presenter Duration

I. Opening Items

A. Record Attendance and Guests

B. Call the Meeting to Order

C. Approve Minutes Approve
Minutes

Andy
Jamieson

II. Academic Achievement

A. CEO Report on class of 2015
graduation rate

Vote Gina
Fafard

10

Gina will be presenting information related to the overall graduation rate of
the 2015 class and the acceptance into ongoing educational institutes as
part of our college acceptance expectations.

III. CEO Support And Eval

A. Approval of BoardOnTrack CEO
Evaluation Process

Vote Gina
Fafard

5

IV. Development

A. Review of New Compensation
Package

FYI Gina
Fafard

10

new information type new info
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V. Facility

VI. Finance

A. Present audit plan FYI Roger
James

5

Present current timeline for financial audit

B. Present current plans for overall fund
raising status

FYI Pedro
DaVinci

5

Present the details of overall fundraising from philanthropic sources,
private and board.

C. Finance Committee Report FYI Marci
Cornell-
Feist

10

D. Last Minute Report Discuss Dave
Britton

10

VII. Governance

VIII. Other Business

IX. Closing Items

A. Adjourn Meeting Vote
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Cover Sheet

Approve Minutes

Section: I. Opening Items
Item: C. Approve Minutes
Purpose: Approve Minutes
Submitted by:
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Picasso Academy (BOT Demo)

Minutes

Board Meeting

Date and Time
Thursday May 12, 2016 at 6:00 PM

Location
13530 Aviation Boulevard – Hawthorne, CA District Office Boardroom

All Picasso Academy Board meetings are open to the public and will start promptly at
the scheduled time. Anyone who wished to speak during the public comment section of
the meeting must submit their request at least 48 hours in advance of the board
meeting in writing to the board secretary, Maria Monet, c/o Picasso Academy Main
Office.

Board Members Present
B. Carpenter, K. Klimt, K. Mellon (remote), M. Monet, P. DaVinci, S. VanGogh

Board Members Absent

I. Opening Items

A.Record Attendance and Guests

B.Call the Meeting to Order
B. Carpenter called a meeting of the board of directors of Picasso Academy (BOT
Demo) to order on Thursday May 12, 2016 @ 6:00 PM at 13530 Aviation
Boulevard – Hawthorne, CA District Office Boardroom.

C.Approve Minutes
B. Carpenter made a motion to approve minutes from the Academic Excellence
Committee Meeting on 02-01-16.
P. DaVinci seconded the motion.
The board VOTED unanimously to approve the motion.
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II. Closed Session

A.Vote to enter Closed Session
B. Carpenter made a motion to enter closed session.
M. Monet seconded the motion.
The board VOTED unanimously to approve the motion.

B.New item

III. Open Session

A.Declaration of Closed Session discussion/action
There was no reportable action during Closed Session.

B.Pledge of Allegiance to the Flag
The Pledge of Allegiance to the Flag was led by Ms. Gloria White

IV. Special Presentation

A.Schoolzilla Data System
Dr. Chris Jones and Gloria White provided an update on the new Schoolzilla data
system. The goal of Schoolzilla is to enable both Wiseburn and Da Vinci to
become data-informed entities and also build a data system that can be flexible
and grow with us.

Ms. White shared several sample dashboards with the Board, including
dashboards for attendance, CELDT testing, the Smarter Balanced Assessment and
College Persistence. Particularly in the area of College Persistence, Da Vinci and
Wiseburn are leading the way. The Board was extremely impressed with the
Schoolzilla presentation and looks forward to another presentation in the fall.

B.Chartwells – “Food / Plate Waste”
Janet Lusk and Zaily Llamas from Chartwells provided the Board with a
presentation regarding a study that Chartwells conducted at Cabrillo and Dana
Middle School regarding student consumption of food, student preferences and
waste.

In this study, Cabrillo was the intervention school and Dana was the control
school. At the control school, the highest waste fraction were fresh fruits, salad
and cold vegetables. The lowest waste fraction were entrée and starchy
vegetables. At the intervention school, the highest waste fraction was salad, cold
vegetables and flavored milk. The lowest waste fraction was entrée and starchy
vegetables. The least popular foods were white milk and canned fruit. The most
popular foods were the entrees and starchy vegetables. The object of the study is
to determine what nutritious foods are most popular and ultimately greatly
reducing or eliminating student waste. Towards this end, Chartwells is conducting
tasting tests and looking at testing new foods through surveys before serving
them.

C.PFMG Solar
PFMG Solar (Partners for Many Generations) provided the Board with a
presentation on a potential solar project in Wiseburn. They shared information
regarding power consumption at all four schools and potential solar panel
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configurations that would generate 72% of the necessary electric power for our
schools. The solar power project has several benefits. One is a positive impact on
the General Fund. There are also benefits related to educational enrichment,
improved security, positive PR and it is both clean and green.

Wiseburn would be able to access solar panels with no investment of General
Fund revenues through a power purchase agreement. Currently the Redondo
Beach Unified School District is in the 2nd year of implementation of solar power
with PFMG and several other local districts are also looking at this possibility.

V. Information

A.From the Board
Dr. Goldman shared that he had attended the Wiseburn Education Foundation
(WEF) Board meeting. WEF has new leadership with Debbie Felt as the president
and Willis Chang as the Vice President.

In closing, Dr. Goldman thanked Dave Wilson and Dr. Johnstone for their fine work
on the refinancing of $37,000,000 in General Obligation Funds that will save
Wiseburn taxpayers $8,000,000 over 26 years.

Ms. Kaneda thanked staff for bringing the field trips up for approval before the
kids actually take the trip.

B.From the Chief Business Official

C.From the Deputy Superintendent
Dr. Jones shared an update on the review of new English Language Arts materials
for possible adoption in 2017-18. Wiseburn is looking at four different companies
for a K-5 adoption. Using call-out days, there have been presentations from the
four companies over two days. The initial plans would be to pilot two of the
potential textbook adoptions in the fall. Dana Middle School is conducting a pre-
pilot with two companies, McGraw-Hill and Study Sync.

Dr. Jones shared that Summer School this year will take place at Anza School and
will include intervention and Special Education Programs and the Summer School
Principal will be Dana Middle School teacher, Kiana Brede.

In closing, Dr. Jones shared with the Board a report from the trip that he and Dr.
Wunder and Da Vinci Extension Principal, Kim Merritt, made to Southern New
Hampshire University.

Southern New Hampshire University is a non-profit university and also has a large
online component with 70,000 students. They have a third program that is called
College for America that is directly connected to industry. The annual cost for a
student to attend this program is $5,500 and currently the program results in an
Associate of Arts degree but they are developing a four-year degree. The program
is competency based and the students who participate in the program must
belong to a partnering institution. Currently, College for America is matched with
charter schools in the Boston area and is focused on students who have dropped
out of college (college recovery). Da Vinci is exploring the very real possibility of
becoming the first pilot in California. This is a very innovative and cost-effective
program and is yielding extremely positive results.

D.From the Director of Facilities Planning
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Mr. Madsen shared that the plans for Phase II of the construction of Wiseburn High
School will be coming out next week and that Balfour Beatty and Gensler would
also be providing cost estimates for all of the aspects of Phase II. On June 9th,
Gensler and Balfour will present this cost estimate package to the Board.

Mr. Madsen also shared that the funding letter for the last round of charter school
money -- $32,500,000 -- will be submitted on May 11th. Mr. Madsen shared that
Da Vinci Design and Communications no longer have heat. The gas line at
Sepulveda is completely corroded and has been shut off. The plan would be to
assess the damage and repair it during the summer.

E.From the Superintendent
Dr. Johnstone shared a letter of appreciation from Cabrillo parent, Bronwyn
Shields thanking Cabrillo teachers, Dee Dee Zirbel and Debbie Davis for their
outstanding work with her son.

Dr. Johnstone provided the Board with an update on the parent conference
calendar for the 2016-17 school year. The District is working with WFA to explore
options to reduce the number of weeks that parents would have to have their
children on a modified schedule. This relates to the fact that many of our families
have kids at multiple levels of the Wiseburn system, K-2, 3-5, Dana and high
school.

Dr. Johnstone shared with the Board where Da Vinci High School students have
been accepted to college this year. The list of college admissions is again very
impressive this year with Da Vinci students being accepted at every UC, four Ivy
League schools, Stanford, USC, Pepperdine, LMU and scores of others.

Dr. Johnstone shared the good news that both Burnett and Anza schools have
been accepted into the COTSEN program next year that will provide extensive
mathematics training next year to 14 of our teachers across the schools. This is a
huge accomplishment that will make a big difference in our math instruction in
the years ahead.

Dr. Johnstone shared that Dana Middle School has been selected by the Boeing
Corporation to have Wiseburn middle school students be able to work side-by-side
with Boeing engineers on Saturday, July 16, 2016.

In closing, Dr. Johnstone shared that Little League District 37 will be selling
fireworks in front of the District Office during the week before the 4th of July.

VI. Action Items - General

A.Action Items

B.Consider Adoption of Resolution #15/16.32
P. DaVinci made a motion to adopt Resolution #15/16.32 – Regarding Layoff of
Classified Personnel – on Behalf of the Southwest SELPA.
S. VanGogh seconded the motion.
The board VOTED unanimously to approve the motion.

C.Approve Interdistrict Attendance Agreement with Charter Oak Unified School District
The item related to the approval of an Interdistrict Attendance Agreement with
Charter Oak Unified School District beginning in July 2016 for the 2016-16 school
year for a term of five years was tabled for further discussion.
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D.Approve an Agreement with National Demographics Corporation (NDC)

VII. Closing Items

A.Adjourn Meeting
There being no further business to be transacted, and upon motion duly made,
seconded and approved, the meeting was adjourned at 7:58 PM.

Respectfully Submitted,
R. James
The next Regular Meeting of the Board of Trustees will be held Tuesday, May 24,
2016, at 5:00 p.m. in the Performing Arts Center of Juan Cabrillo School.
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Cover Sheet

CEO Report on class of 2015 graduation rate

Section: II. Academic Achievement
Item: A. CEO Report on class of 2015 graduation rate
Purpose: Vote
Key Result: Graduation Rate
Submitted by:
Related Material: BOT Demo Slides.pptx
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www.BoardOnTrack.com

BoardOnTrack
Improve Your Board’s 

Performance 
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www.BoardOnTrack .com

What We’re Going to Cover
► Give You a Brief Background of BoardOnTrack
► Review BoardOnTrack’s Annual Membership
► Give You an Overview of BoardOnTrack’s Board 

Performance System
► Q & A along the way!
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www.BoardOnTrack .com

What is BoardOnTrack?
► BoardOnTrack is a guided step-by-step program 

designed to  help you build a better board 
based on best practices we’ve collected over 
time from working with over 500 charter school 
boards. 

► We will help your board use data in meaningful 
ways that guide board development and 
customize training.

► As your organization evolves we’ll help you 
develop structures and processes that allows 
you to manage complex issues and meet your 
strategic objectives.
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www.BoardOnTrack .com

JUDY add whatever
► Your Board has voiced…. 
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Cover Sheet

Present audit plan

Section: VI. Finance
Item: A. Present audit plan
Purpose: FYI
Key Result: Ensure successful financial audit
Submitted by:
Related Material: Budget.xlsx

Event.pptx
Newsletter.docx
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To get started right away, just tap any placeholder text 
(such as this) and start typing.

Heading 1
View and edit this newsletter in Word on your computer, tablet, or phone. 
You can edit text; easily insert content such as pictures, shapes, and tables; 
and seamlessly save the document to the cloud from Word on your Windows, 
Mac, Android, or iOS device.

Want to insert a picture from your files or add a shape, text box, or table? 
You got it! On the Insert tab of the ribbon, just tap the option you need.

Think a document that looks this good has to be difficult to format? Think 
again! This newsletter uses styles so that you can apply the formatting you 
need with just a tap.

Newsletter Title
Volume 1 | 

Issue 1
Date

Add a sidebar or 
pull quote here

Add a sidebar or 
pull quote here
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2

Heading 1
Heading 2
On the Home tab, check out Styles to access any text format you see in this 
document. For example, this paragraph uses Normal style.

Heading 2
On the Home tab, check out Styles to access any text format you see in this 
document. For example, this paragraph uses Normal style.

 Heading 1
Address | City, ST Zip
Telephone | Email 

Company
Address
City, ST Zip

Recipient
Address
City, ST Zip
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Attachments
The following files are attached to this PDF: You will need to open this document in 
an application that supports attachments (i.e. Adobe Reader) in order to access these 
files.

Budget.xlsx
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Manage My Money

				Budget

				% of Income Spent		Summary

						Total Monthly Income

						$3,750

						Total Monthly Expenses

						$2,058

						Total Monthly Savings

						$550

						Cash Balance

						$1,142

				55%

				Monthly Income

				Item		Amount

				Income Source 1		$2,500.00

				Income Source 2		$1,000.00

				Other		$250.00



				Monthly Expenses

				Item		Amount

				Rent/mortgage		$800.00

				Electric		$120.00

				Gas		$50.00

				Cell phone		$45.00

				Groceries		$500.00

				Car payment		$273.00

				Credit cards		$120.00

				Auto insurance		$50.00

				Miscellaneous		$100.00



				Monthly Savings

				Date		Amount

				[Date]		$200.00

				[Date]		$250.00

				[Date]		$100.00



Page &P of &N	


0.4512	0.5488	



Chart Data

				CHART DATA

				45%

				55%

				FALSE





